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WELCOME 

Congratulations! You’ve chosen to participate in Disney’s Planet Challenge (DPC). The DPC was 

designed to provide a comprehensive, educational, and creative way raise student awareness of 

environmental issues.  

 

We are really looking forward to helping you create a digital portfolio. It’s fun, easy, and 

environmentally conscious too (no paper!). With a digital portfolio, you can do everything you 

would do with a hard copy, like adding original photos and text, plus extra features, like linking 

to websites and including videos on your portfolio pages. And whether you choose to submit a 

hard copy portfolio or a digital one, the judging process is the same.  

 

As you and your class begin to create your portfolio, it’s important to remember that, as the 

teacher, you are responsible for compiling the students’ work and submitting it to the competition. 

This process includes ensuring that the profile information is accurate and that the Cover Sheet 

and Student and Teacher Reflections have been completed. Our judges evaluate every project 

primarily based on the work done by the students. With this fact in mind, please be aware that 

although you control access to the digital portfolio application, your students can and should be 

responsible for creating and completing the portfolio pages themselves, with proper supervision.  

 

We recommend you review the entire tutorial before you introduce it to your class. You may want 

to create a few practice pages on your own in order to become more familiar with the 

application and its features. If you have any questions, please contact the DPC team at 1-877-

235-1399 or email us at 

HOW TO USE THIS TUTORIAL 

This tutorial will guide you through all the basic features of the application. We’ve also included 

Tips and Tricks throughout to help your class use the application more efficiently. And don’t be 

afraid to experiment – your students may discover a tip or a trick even we didn’t know about!  

 

http://disney.go.com/planet challenge/contact_us.html. We would also 

love to hear from you via email about the tips and tricks your class has discovered, with your 

permission to add them in future versions of the tutorial.  

 

Turn the page to get started.  Ready! Get set! Go Disney!  

http://disney.go.com/planet%20challenge/contact_us.html�
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BEFORE YOU START YOUR DIGITAL PORTFOLIO 
 
 
PLANNING YOUR PROJECT 
 
Creation of a digital portfolio is the final step of Disney’s Planet Challenge. Your portfolio 
should be an informative and creative way to illustrate the actions your class took to 
address an environmental issue in your community. By the time you are ready to create 
your portfolio, your students should have a greater understanding of environmental issues, 
have met a wide range of state standards, and feel more confident in their ability to solve 
problems and make decisions.  
 
Before you begin your portfolio, you should have completed most of the tasks listed in the 
Project Checklist, below. For a more detailed explanation of how to complete your 
project, please refer to the Disney Planet Challenge Handbook. You can download a copy 
at http://disney.go.com/planetchallenge/tools_resources.html. 
 
Project Checklist 

1. Determined the objectives of your project.  

2. Developed an action plan and timeline.  

3. Utilized tools and resources (library, internet, interviews, field trips, etc.) to plan 

and conduct the project. 

4. Formed student action committees such as publicity, funding, research, history, 

materials, and artwork.  

5. Determined the specific science content to be understood by the students.  

6. Completed the Activity Record Logs.  

7. Conducted pre- and post-project observations. 

8. Recorded Student Reflections throughout the project. 

9. Kept the school and community informed of your progress. 

10. Gathered and recorded all your project data. 

11. Created materials to illustrate and support your data (charts, graphs, tables 

pictures, video, surveys, interviews, etc.).  

http://disney.go.com/planetchallenge/tools_resources.html�
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12. Observed and recorded measurable changes from the beginning to the end of the 

project. 

13. Conducted experiments.  

14. Completed all steps to evaluate the project.  

 
 
 
 

  



   
 
 

6 

 

PREPARING YOUR CONTENT 
 
Once you have completed your project research and implementation, you are ready to 
create your portfolio. Please refer to the portfolio guidelines on pages 26-27 of the DPC 
handbook. For examples of past portfolios, please visit 
http://disney.go.com/planetchallenge/tools_resources.html. 
 

To ensure your portfolio creation goes as smoothly as possible, you should take steps to 
prepare your content, as listed in the Content Checklist, below.  

 
Content Checklist 
 

1. Written your Teacher Reflection page.  

2. Completed and collected student Reflection pages.  

3. Collected photos, articles, and student communications to include in portfolio.  

4. Explained the scoring rubric to your students. 

5. Chosen a variety of artifacts and student pages from the DPC handbook to include 

in the portfolio.  

6. Assigned different portfolio tasks to student groups.  

7. Scanned in all the articles, photos and images you will use in the portfolio.  

8. Made copies of every piece of documentation to be included in portfolio.  

 
To help you prepare your content for the Cover Sheet, Teacher Reflection, and Student 
Reflection, you may download worksheets from the DPC handbook for you and your class 
to fill out as practice. The questions on these worksheets are identical to the questions in 
the digital portfolio pages.  

 

  

http://disney.go.com/planetchallenge/tools_resources.html�
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CREATE YOUR PORTFOLIO 
Whether you are beginning a new portfolio or to continuing to work on your existing one, click the 
Launch Digital Portfolio button on the Teacher Admin page after you have logged in at 
www.dpcproject.com. You will be linked to the digital portfolio application.  

 

Fig. 1 

The Digital Portfolio application allows you to create portfolio pages with text, images, 
backgrounds, and video. You can preview your portfolio as you work, and you will be able to 
modify it at any time before you submit it to the judges.  

 

 

Fig. 2 

Figure 2 shows a default portfolio page. On the left of the screen are buttons to add images, 
backgrounds, text and video.  

The white center area shows your portfolio page in progress.  

The top of the screen contains pull down menus with tools to create your portfolio (some of which 
are repeated in the Toolboxes) as well as the Save, Print, and Preview buttons.  

Portfolio page  

Toolbox   

Menu Bars  

Library  

Page Selection Bar 

http://www.dpcproject.com/�
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On the far right there is a toolbox that allows you to customize the current portfolio page. This 
toolbox changes depending on whether you are working with images, text, or video.  

Throughout the tutorial, you’ll see TIPS and TRICKS that will help you use the application more 
efficiently.  
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ADD IMAGES 

To add an image to your portfolio page, click on the “Images” button shown below. 

 

Fig. 3 

The Images Library will expand and display the “Upload Images” button. 

 

Fig. 4 

The digital portfolio application allows you to upload your own images from your computer. 
These can include photos, artwork, charts, reports, and any other graphics created during your 
project.   

To upload an image from your desktop, click the “Upload Images” button (Fig. 4) at the top of the 
tab. A dialog box will open, allowing you to search your computer to find your desired image 
file.  

When you have selected your image, it will appear as a thumbnail in the Image Library. 

 

 

 

 

 

 

 

Fig. 5 

TIP: To remove a custom image from the Image Library, just click on the garbage can icon on the 
bottom right corner of the thumbnail. If you need to retrieve it, repeat the upload process and 
select the image again.  

IMPORTANT: Remember to hit “Save” after you have uploaded new images or videos to your 
asset libraries. If you upload files to your portfolio but do not save, you will have to upload the 
assets again the next time you launch your application. 

To insert the image into the portfolio area, simply drag and drop it in.  
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TIP: We have provided a few default images that you may use in your portfolio. Go ahead and 
try clicking and dragging one of them onto the blank page. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 6 

Your image will appear on the portfolio page automatically selected, with a light border around 
the image, the corners of the image marked with small resizing squares, and a rotation circle at 
the top.  

You can then adjust the size of your image by grabbing any corner of the image with your mouse 
and dragging to make it bigger or smaller.   

To change the position of your image, click to select again and click and hold your mouse 
anywhere inside the image to drag it around the screen until you’ve placed it where you want it 
to be.  

You can also change the rotation of the image by selecting it, grabbing the circle at the top of the 
image, and dragging it with your mouse.  
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Click anywhere in 
your image and drag 
to move it around the 
page.  

Use this circle to 
rotate your image. 

Grab any of these 
corner squares to size 
your image.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 7 

Grids and Guides 

In the design phase of your project, it’s a good idea to use the Guides and Grid tools. These tools 
can help you make sure your images, textboxes and videos are perfectly aligned vertically or 
horizontally on each page.  

To set a horizontal Guide, go to the horizontal ruler at the top of the page. Click and drag a 
horizontal Guide down onto the page. To set a vertical Guide, click on the vertical ruler and drag 
a guide out from it onto the page. Once you have set a Guide, you can reposition it by moving 
your mouse over it, then clicking and dragging to the desired location on the page (Fig. 8).  
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Guide lines 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 8 

You can “snap to,” or position the Guide lines flush against your image to ensure that it is 
perfectly straight and positioned exactly where you want it to be on your portfolio page.  

To add additional Guide lines, repeat the process above. To hide the Guides option, deselect the 
option from the “View” pull-down menu.  

To remove a guide, drag it back to the ruler. 

TIP: You do not have to choose Guides from the “View” pull-down menu in order to use the 
Guides, just to hide them.  

To use the Grid tool, go to the “View” pull-down menu and click on Grid.  
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Fig. 9 

The Grid will appear on your portfolio page. The Grid consists of tiny vertically and horizontally 
aligned dots.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 10 

You can use the Grid to line up your images or to position them at regularly spaced intervals (Fig. 
11).  
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The images are exactly five 
gridlines apart.   

 

 

 

 

 

 

 

Fig. 11 

You may use either the Guides or the Grids at any time as you create your portfolio, but you may 
not use both at the same time. To toggle between them, use the “View” pull-down menu to select 
and deselect the choices as you go.  

Once you have adjusted your image’s size, placement, and rotation use the Image Toolbox in the 
right-hand column for additional customization.  

TRICK: If you are pasting an image from one page to another and want it to be identical in size 
and placement, choose “Paste in Place” from the “Edit” pull-down menu at the top of the page 
when pasting the image on the new page.   
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Image Toolbox 

These are the tools you’ll need to edit your images. The tools in this area will change depending 
on whether you are working on images, text, video, or backgrounds.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
Fig. 12  

This button moves your 
image forward, to overlap 
an image, text or video 
behind it   

This button moves 
your image behind 
text, another image 
or a video.  

These buttons allow 
you to flip an image 
horizontally or 
vertically.   

Scroll left or right on 
the opacity scale to 
control the 
transparency of your 
image.  

Click the check box to 
add a border to your 
image. You can also 
adjust the color and 
weight of the border.  

Click on the Crop 
Button to crop parts 
of your image.  

Click on this button to 
make your image linkable 
to another web page.  



   
 
 

16 

 

ADD TEXT 

Click on the “Text” button to add text to your portfolio page. 

 

Fig. 13 

The Text Library will expand, which contains the text box icon.  

 

 

 

 

 

 

Fig. 14 

Drag and drop the thumbnail into the portfolio page. You will see a text box with sample copy 
(Fig. 15).  

Double click on the text box to delete, change, and add your own text. Once you have entered in 
your text, click outside the area to set the copy changes. Click on the text area one more time to 
select the whole text box.  
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Fig. 15 

 

You can also drag, rotate, and change the size of your text, similar to the way you edited your 
images.  

The existing text box icon is the only asset in the Text Library. As you add additional text to your 
page, you will not see additional asset thumbnails in the library. To save any text you have 
added to the page during your session, remember to hit “Save.” To ensure that you keep all the 
text you have added for the next time you login, remember to save your portfolio changes often.  

To make more changes to your text, use the Text Toolbox on the right of your screen (Fig. 16).  
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Text Toolbox 

These are the tools you’ll need to edit your text. The tools in this area will change depending on 
the design element you are working on: images, text, video, or backgrounds.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 16 

For more instruction about adding a fill color, border, or changing font color, please see pages 
19-24.  

Use these buttons to 
change the font, size, 
color, and other 
styles of your text.    

These buttons will 
align your text 
within the text box.    

Click on the color 
swatch to adjust the 
background color of 
the text box.    

Click here to add a 
border around your 
text box.  

This button moves 
your text forward to 
overlap other text or 
images behind it.    

This button moves 
your text behind an 
image or another 
textbox.    

These buttons allow 
you to flip text 
horizontally or 
vertically.    
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Click the color swatch 
to choose a fill color 
for your textbox.    

The color you have 
chosen 

Your most recent 
color choice 

Your current fill color 

When you are 
satisfied with your 
color choice, click in a 
swatch box to save it.  Click OK to accept your 

fill color and go back to 
your portfolio page.  

Scroll up or down 
to choose a color 
palette. 

Fill Colors 

If you want to add a fill color to your textbox, click on the “Fill Color” color swatch in the Text 
Toolbox.  

 

 

 

Fig. 17 

A window will open that you can use it to choose a fill color for your textbox (Fig. 18).  

Scroll up or down on the spectrum on the right to choose a color palette. Next, drag your mouse 
around the color square to choose the brightness and saturation within the color you have chosen.  
The corresponding color in the “new” box on the upper right will change as your mouse moves. 
When you have decided on a color, click on the color swatch squares below to save it. You will 
notice at the top that you have two colors – one is the current background color of your textbox, 
and the other is the color you have just chosen.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 18 
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Next time you click on the fill color button, the color(s) you have saved will be included in the 
swatch box(es).  

When you return to the Text Toolbox, you will see that the “fill color” swatch is now the color 
you’ve chosen. To fill the background of your textbox, click on the checkbox. 

 

 

 

Fig. 19 

 

Borders 

 

 

 

Fig. 20 

 

The process of choosing a border color is identical to that of choosing a fill color. 

When you return to the Text Toolbox, you will see that the border color swatch is now the color 
you’ve chosen. To create the border, click on the checkbox. 

 
Font Color 
The process of choosing a font color is identical to that of fill and border colors.  

When you return to the Text Toolbox, you will see that the font color swatch is now the color 
you’ve chosen.  Your font has also changed color.  

 

 

 

 

 

Click here to implement 
your choice. 

New fill color 

Click on the color 
swatch to open the 
border color window.  
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Font color 
Fill color  

Border color 

After you’ve made your color choices, your page may now look something like this: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 21 

 
TRICK: You can add a shadow effect to your text by selecting a text object, copying it and 
pasting it. Change the font color of this new text to black and move it one layer behind your first 
text, using the “Backward” button on your Text Toolbox. Adjust the angle of the shadow by 
moving the black text up, down, left or right. 
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ADD VIDEO 

To add a video to your portfolio, click the “Video” button.  

 

Fig. 22 

The Video Library will open and display the “Upload Video” button.  

 

 

 

Fig. 23 

To add a video to your portfolio page, click the “Upload Video” button and browse through your 
files until you find your desired video.  

IMPORTANT: Please only upload the following video formats: 

• WMV 
• MOV 
• AVI 
 

If your video does not have one of the extensions listed above, please do not attempt to load it 
onto your portfolio page. 

Once you select your video, the loading process will begin. The film icon will tell you when the 
video is loading, processing, and ready to use (Fig. 24).  
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Video is 
uploading.  Video is 

processing. 

Video is 
ready to be 
inserted into 
portfolio 
page.  

 

 

 

 

 

 

 

 

 

 

Fig. 24 

IMPORTANT: The video upload process can take up to 30 minutes to complete. If you have a 
slower connection, the process may take longer.  

If your video is not in the “Ready” state after two hours, please contact the DPC team for 
assistance.  

As your video uploads, you will notice that the “Save” button has been disabled. You will not be 
able to save your portfolio until your video has completed uploading.  

Once your video is ready, you can drag and drop it into the portfolio area just as you did with 
the images and text boxes.  The video icon will appear as a black box with a red “X” in the 
middle (Fig. 25). This visual will change after you play your video the first time.  
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Your video will 
appear like this until 
you play it the first 
time.   

 

 

 

 

 

 

 

 

 

 

 

Fig. 25 

You may also select your video to change its size, rotate it, or move it to a different position on 
the page.  

 

 

 

 

 

 

 

 

 

 

 

Fig. 26 
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Use these buttons to 
rewind, pause, and 
play your video.  

To play, pause, or stop your video, use the controls in the video toolbox (Fig 27).  

Video Toolbox 

These are the tools you’ll need to view your video. The tools in this area will change depending on 
the design element you are working on: images, text, video, or backgrounds.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 27 

You may insert images, textboxes, and backgrounds on video pages just as you have done on 
pages without videos. You may also copy and paste videos from one page to another.  

IMPORTANT:You may only insert one video per portfolio page. If you drag and drop a second 
video, it will replace the first one you placed on the page. In addition, you may only drag and 
drop one video at a time.  
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You are permitted to include up to five minutes of total video time in your portfolio per DPC 
guidelines.  You can use this time in any way that works best for your project – for example, one 
five-minute video or five one-minute videos.  
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ADD BACKGROUND 

To add a background to your page, click on the “Backgrounds” button. 

 

Fig. 28 

The Background Library will open and display the “Upload Backgrounds” button. 

 

 

Fig. 29 

To add a background, click the “Upload Backgrounds” button and browse through your files until 
you find your desired background. Select it to add to the Background Library, then drag and 
drop it into your portfolio page (Fig. 30).   

TIP: We have provided a few default images that you may use in your portfolio. Go ahead and 
try clicking and dragging one of them onto the blank page. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 30 

You may not add more than one background to a page.  If you choose a new background, it will 
replace the existing one.  
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TIP: To remove a custom background from the Background Library, just click on the garbage can 
icon on the bottom right corner of the thumbnail. If you need to retrieve it, repeat the upload 
process and select the background again.  

TIP: You can find a variety of downloadable background designs at no cost on stock photo 
websites. Just make sure to download the background you select to your desktop before you 
upload it into your portfolio.   

TRICK: To make modifications to a custom background, or to use an image or photo as a 
background, you may upload it under the image button. Once you have included the image in 
your Library, drag and drop it onto the page, then use the mouse to expand it to fit. Select the 
background image, then adjust the opacity of your image (found in the Image Toolbox) to fade it. 
If necessary, you can click “send to back” (also found in the Image Toolbox) in order to ensure 
your portfolio page content remains in the front and as the focus of the page. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 31 

TIP: When downloading images you are planning to use as background, choose one with a high 
resolution in order to avoid pixilation.  

  

Image used as 
background.   
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Thumbnail of 
new page 

Image 
added to 
library 

ADD PAGES 
To add a page to your portfolio, go to the Pages pull-down menu and select “New Page.” 

  

 

 

 

Fig. 32 

A new portfolio page will appear on your screen, and a new portfolio page thumbnail will 
appear on the Page Selection Bar of your screen.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 33 

As you continue to work on your portfolio, you can navigate among your pages by clicking the 
thumbnails at the bottom of your screen.  

You also may delete or clear all the images on your page by choosing the menu option, as shown 
in Figure 32.  
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As you add additional images and videos to your pages, the page thumbnails will update to 
reflect the changes on the actual page.  

IMPORTANT: You can only create and edit up to 16 pages in your digital portfolio.  
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Click here to 
see all page 
Thumbnails.   

Click the 
arrow 
buttons to 
skip to the 
next or 
previous 
pages.   

PREVIEW 

You will be able to preview your portfolio at any time by clicking the “Preview” button at the top 
of the screen.  

 

Fig. 34 

Clicking this button will bring up a new window with preview player controls.  

 

 

 

 

 

 

 

 

 

 

 

Fig. 35 

Click the “Play” button to preview your portfolio from the first page.  

To begin previewing your portfolio from another page, click on “Show Thumbnails,” and click to 
select the page you want to start viewing. 

You can adjust the speed and volume of the preview by moving the bars on the sliders.  
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SAVE AND PRINT 
To save your portfolio, click the “Save” button on the top portion of your screen.  

 

Fig. 36 

IMPORTANT:In order to save all your most current work, we recommend that you save often while 
you are working on your portfolio as well as before you quit the application.  

When you sign back into the application, your portfolio-in-progress will load automatically.  

 

To print your portfolio, click the “Print” button on the top portion of your screen.  

 

Fig. 37 

You may only print the page of the portfolio you are currently working on. To print the entire 
portfolio, you must repeat the printing steps for each page.  
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